VETUS LATINA IOHANNES DATABASE

Transcription guidelines for direct entry of Church Fathers
Version 1.1
updated 30.10.06

Contents
1. Background
2. Software
3. Database fields
4. Transcription conventions
5. Excel hints
6. Other comments

1. Background

For the new edition of the Vetus Latina *Iohannes*, the main aims of compiling a list of citations of John directly from editions of Church Fathers are to act as a control on the material already assembled in the Vetus Latina Database (Beuron cards) and to update that material where a new edition has been published. Nonetheless, this work is valuable in its own right as new research. As well as supplying additional entries to the database, by including information about the context of each citation it enables the study of the Father’s citing habits. This is of vital importance when it comes to assessing the weight to be assigned to each citation as textual evidence for the state of the Gospel. Furthermore, the assembly of the text of John in an individual Father from modern critical editions also permits a study of the transmission of the biblical text over a patristic corpus and allows that Father’s Gospel text to be compared afresh with surviving Vulgate and Vetus Latina witnesses.

The Beuron cards and Patristic indices will be entered into databases of identical design with the same conventions, as set out in this document. These databases will then be combined and refined to produce a single entry for each citation which will be used in the production of the edition.

2. Software

These instructions assume the use of the Microsoft Excel spreadsheet program for data entry: Excel is available for both Macs and PCs and has a simple, table-like structure into which entries can be typed directly. A database template will be sent to all members of the team, which should be saved onto the local machine and used directly for the entry of new data. This should be backed up regularly and also sent to a co-ordinator for storage on the central University server.

We are aiming from the outset to ensure compatibility between the Latin database and potential citation databases in other languages.

3. Database fields

The principle for our transcription is to include as much information as possible without editorial intervention when the record is initially entered. This should mean that we do not have to go back to the cards to enter addition information later, although some of the original data may be abbreviated. If in doubt, include it (or note it in the Comments field).
When taking text from an edition of a Church Father, four elements are of interest:

1. The exact reference for the citation in the work and in the edition. This indicates where the biblical text (or allusion) begins in the text.
2. Any prefatory material before the beginning of the citation proper. This may range from a couple of words (e.g. *dixit dominus*) to a whole sentence. This should be transcribed without alteration, although some abbreviation may occasionally be necessary.
3. The text considered to be a biblical citation or allusion. This must be entered exactly as it appears in the edition, with interruptions (e.g. *inquit*) and variations intact. Only when we have the entire text of an author’s citations can we start comparing it with surviving witnesses. It is likely that there will be considerable variation even within an author’s citations of the same verse.
4. Any other biblical citations in the vicinity of the reference to John. These are entered in the *catena* field, and may provide information as to a Father’s sources.

The database consists of the following fields:

a) **book** (John is 04).
b) **chapter** (double figures, i.e. 01, 02...20, 21)
c) **verse** (double figures, i.e. 01, 02...72)
d) **Author** (using the Frede abbreviations in Frede *Kirchengeschiftsteller* 1995)
   Thus Augustine is AU, Hilary of Poitiers is HIL, Jerome is HI, Fulgentius the Donatist is FU-D.
   Note that the Beuron cards sometimes use an older scheme, which needs to be updated.
e) **Work title** (again, using the Frede abbreviations)
f) **Work reference** (the book, chapter or paragraph and line of the citation).
   This information will vary from edition to edition. Use full stops as dividers, starting with the biggest unit (e.g. book, chapter) and work down to the smallest (paragraph, line) e.g. 1.2.4 (for book 1, chapter 2, line four). Not all editions have continuous line numbers: do not include line numbers which begin afresh on each page here, but in (h) below.
g) **Edition** (editor’s name and date, or series and volume number, e.g. Zycha 1901 or CSEL 41)
   This information will make our work compatible with the Editio Critica Maior citations.
   Common abbreviations: CC - Corpus Christianorum, CSEL - Corpus Scriptorum Eccl. Lat. (sometimes known as the Vienna Corpus), PL - Migne Patrologia Latina.
   In the case of Beuron cards where the edition is not indicated, simply enter "Beuron".
h) **Page** (page number of the edition) and the line number (if the edition has line numbers which start again on each page). These should be separated with a full stop (e.g. 41.23 means page 41, line 23). If there are no line numbers, just enter the page number (e.g. 41).
i) **Clavis number** (CPL). (Can be added centrally when it is imported into the database)
   This reference number is found in square brackets on the right hand column of Frede 1995; most are four digits. Each Latin patristic work has a unique Clavis number (and patristic works in Greek have a similar code).
j) **Introduction.** (Text preceding the citations.)
   The benefit of this information is to see how specific authors are in their introduction of citations (do they specifically name the Gospel, or Bible? Do they refer to a codex?) If a citation has no specific introduction, the preceding words (e.g. the last phrase of the previous sentence) may still be included as an indication of context. Do not enter other biblical references into this field, but into the Catena field (see (m) below).
k) **Citation.**
   The text of the passage designated as citation (this may be a verbatim citation, adaptation or allusion). This will vary in its correspondence to known biblical types, but as close a fit as possible should be sought without any alteration to the authorial text. Brief interruptions to the text should be included in braces (curly brackets), e.g. *in principio* [*inquit euangelista*] *erat uerbum.* Longer non-biblical interpolations may be omitted, and indicated by the
omission sign in braces, e.g. *et uerbum {...} caro factum est*, but such omissions should be kept to a minimum where possible. Capital letters and punctuation should be included: see further the Transcription procedures below.

l) **Manuscript variants.**

Details on the manuscript variants may be found in the critical apparatus at the foot of each page. These should be reproduced as they stand. (Variants not directly affecting the biblical texts are not normally significant for our purposes.) The format will be something like the following: *hoc] haec C Am1 L, where hoc is the editorial reading, haec the variant and C, A and L manuscript sigla. It may be necessary to filter the amount of information recorded here, especially in the case of longer variants, but all widely-attested or particularly interesting readings should be recorded; if information is required about the manuscripts themselves, we will have to refer back to the edition. (Details about manuscript variants will enable us to see if there is any evidence of the alteration of biblical text during the transmission of the work).

m) **Catena.**

A number of authors include citations in the context of other citations, or verses in groups. This is significant both for the text of the citations and their possible source. Scriptural references adjoining the citation should be recorded in this field, using Latin abbreviations for the biblical books. The reference of the citation itself should also be given to indicate its place in a catena. Thus for a citation of John 10:11 preceded by Leviticus 15:4 and followed by Mark 13:19, the catena field will read: "Lv 15:4, Io 10:11, Mc 13:19". For a citation of John 7:37 as part of a longer citation of John 7:35-39, the catena field will read: "Io 7:35-39".

n) **Category.**

The citation may be categorised as CIT (verbatim), ADAPT (adaptation) or ALL (allusion) by the transcriber on the basis of its context and/or conformity with known biblical texts.

o) **Cross-reference.**

This field is included for cross-referencing to related patristic works, e.g. letters which appear among the writings of both correspondents, or portions of text in one author quoted by another. The Frede abbreviations should be used; such references are included on the Beuron cards although they may be rarer in editions.

p) **Parallels.**

There are several occasions when editors (and the Beuron cards) assign a citation to more than one verse of John. Unless there is a clear correspondence between the citation and one of these references (in which case the other references should be disregarded), the citation should be entered under all references given, and the biblical parallels noted in this field. (e.g. Io 13:34; Io 15:12; Io 15:17).

q) **Comments.**

This field is provided for comments by the transcriber. No special format is required.

r) **Transcriber.**

The initials of the transcriber.

s) **Date.**

The date of entry, to enable tracking of entries/corrections.

4. **Transcription conventions**

- a) The letters "v" and "j" should not be used; only "u" and "i".
- b) Capitals should be used for proper nouns, but not the beginning of sentences.
- c) Basic punctuation should be included, as in the edition or Beuron card.
- d) The system of Latinate abbreviations of biblical books should be used (as in the Stuttgart Vulgate p.xliii). The New Testament is as follows: Mt Mc Lc Io Ac Rm 1Cor 2Cor Gal Eph Phil Col 1Th 2Th 1Tim 2Tim Tit Phlm Hbr lac 1Pt 2Pt 1Io 2Io 3Io lud Apc.
5. Excel hints

The template spreadsheet should be correctly formatted. However, if problems are experienced with AutoCorrect, or the re-formatting of numbers, the following steps should be taken:

1) Click on the diamond in the top left corner of the sheet to select all the cells. Then select the Format menu, select Cells, and then select Text (not General) from the menu of possible formats. This will ensure that data is displayed as entered.

2) Click on the Tools menu, select AutoCorrect and ensure that all options are turned off. This is particularly important with Two Initial Capitals, which will otherwise confuse the abbreviations of Author and Work.

You can navigate around the cells of the sheet with the cursor keys. The tab key will move to the next cell on the right. The return key will (normally) move to the cell below. You cannot use the cursor keys to move within the text you are typing into a cell. To do this, you need to click on the one-line window above the sheet where the text of the current cell is displayed and use the cursors. (If you cannot see this window, go to the View menu and ensure that “Formula Bar” is selected. You will need to have a spreadsheet open to turn this on.) If you enter all the fields in succession with the tab key and press return at the end of the line, Excel should catch on and return you to the first cell of the next record.

To duplicate the entry in a particular cell over a range of adjoining cells, click the bottom right corner of the cell and drag over the cells to be filled (i.e. down the column). You may find that a number or date is automatically incremented. To stop this, type the same number in several cells in the column, then select all the cells, and drag to extend the selection.

The keystroke CTRL' (i.e. CTRL key and an apostrophe) duplicates the selection from the cell immediately above.

Excel sometimes has an auto-fill function which can be helpful. If a menu of possible options appears, scroll up and down with cursors, then press TAB when you are on the correct selection to move onto the next cell.

7. Other comments

Backups
Please save your work regularly and back-up your computer onto CD.
There will also be a central backup on the University server. Hugh will have responsibility for ensuring that this is backed-up onto CD. Files may be e mailed to him directly for inclusion on the server.
For ease of reference, we should have consistency in file names. For authors and works, use the VL abbreviations (e.g. J-CIT-AUci for the citations of John in Augustine's De ciuitate dei, or J-CIT-NO for all the citations in Novatian); for Beuron cards, use the format J-CIT-VLD01 for Chapter 1 of John from the Beuron Vetus Latina database.

Greek compatibility
Microsoft Access will handle Unicode (e.g. accented Greek) in any entry in the final database, but this will probably not be importable through the text file. If there is Greek text to be entered, it seems best at present to use a transliteration scheme in Roman characters; notate this with <gk> initially and </gk> at the end of the Greek. This can be converted later.

Version 1.1
Hugh Houghton
9th November 2005